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            Практическая работа – небольшой научный отчет, обобщающий 

проведенную учащимся работу, которую представляют для 

защиты преподавателю. 

В процессе практического занятия учащиеся выполняют одну или 

несколько практических работ (заданий) под руководством преподавателя в 

соответствии с изучаемым содержанием учебного материала. 

Состав и содержание практических занятий направлены на реализацию 

Государственных требований.  

Наряду с формированием умений и навыков в процессе практических 

занятий обобщаются, систематизируются, углубляются и конкретизируются 

теоретические знания, вырабатывается способность и готовность 

использовать теоретические знания на практике, развиваются 

интеллектуальные умения. 

Практические занятия проводятся в форме практической подготовки в 

виде работ, связанных с будущей профессиональной деятельностью. 

К практическим работам предъявляется ряд требований, основным из 

которых является полное, исчерпывающее описание всей проделанной 

работы, позволяющее судить о полученных результатах, степени выполнения 

заданий и профессиональной подготовке учащихся. 

 

I. Практические работы: 

 

Тема практической работы №1. Ознакомление с интерфейсом и 

функционалом офисного пакета (например, LibreOffice или 

отечественные аналоги), объем часов___4__ 

У1. Выбирать способы решения задач профессиональной деятельности 

применительно к различным контекстам. 

У2. Использовать современные средства поиска, анализа и интерпретации 

информации, и информационные технологии для выполнения задач 

профессиональной деятельности. 

Цель практической работы: Освоить интерфейс и базовый функционал 

офисного пакета для сбора, организации и предобработки данных, 

предназначенных для интеграции в модели искусственного интеллекта, с 

учетом профессиональных задач специалиста по работе с ИИ. 



Задание(я): 

1. Установите (или откройте) офисный пакет (рекомендуется LibreOffice 

или отечественный аналог, такой как Р7-Офис). Изучите основные 

компоненты интерфейса: панель инструментов, меню, рабочие области 

для текстового редактора, электронных таблиц и презентаций. 

2. Создайте новый файл в электронных таблицах (например, Calc в 

LibreOffice). Импортируйте простой датасет для ИИ (пример датасета: 

таблица с данными о погоде, источник — 

https://github.com/goodluck08/practice_dataset/blob/main/weather_2012.cs

v ,столбцы: "Дата" (формат ДД.ММ.ГГГГ), "Температура (°C)", 

"Влажность (%)", "Скорость ветра (м/с)", "Осадки (мм)". Пример строк: 

01.01.2025, 5, 80, 3, 0; 02.01.2025, 7, 75, 4, 2; и т.д. на 10–15 строк). 

Выполните базовые операции: ввод данных, форматирование ячеек, 

создание заголовков для колонок. 

3. В текстовом редакторе (например, Writer) создайте документ-описание 

датасета: добавьте заголовки, списки с аннотациями данных (что 

представляют столбцы, источники данных) и вставьте таблицу из 

предыдущего файла. 

4. В программе для презентаций (например, Impress) создайте слайд с 

визуализацией: вставьте диаграмму на основе данных из таблицы 

(например, график зависимости температуры от даты для анализа в 

ИИ). 

5. Сохраните файлы в разных форматах (CSV для ИИ, ODT для 

документации) и организуйте их в папку с иерархией (например, 

"Данные_ИИ/Погода/"). 

6. (Дополнительное задание) Выполните предобработку датасета: в 

электронных таблицах добавьте новый столбец "Категория осадков" 

(формула: если осадки > 0, то "Дождь", иначе "Сухо") и отсортируйте 

таблицу по температуре. Обоснуйте, как это улучшит данные для 

модели ИИ (например, для предсказания погоды). 

Методические указания по ходу выполнения работы (комментарии к 

заданиям, к выполнению заданий): 

• Перед началом убедитесь в наличии офисного пакета на компьютере; 

если нет — скачайте бесплатную версию LibreOffice с официального 

сайта или используйте облачный аналог (например, Р7-Офис Онлайн). 

Для задания 2 используйте предоставленный пример датасета или 

скачайте аналогичный из открытых источников (например, с 

Kaggle.com, но адаптируйте под 10–15 строк для простоты). 

• В задании 2 обращайте внимание на форматирование: используйте 

жирный шрифт для заголовков, выравнивание по центру для чисел — 

это обеспечит качество данных для последующей загрузки в модели 

ИИ (например, в Python с pandas). 

https://github.com/goodluck08/practice_dataset/blob/main/weather_2012.csv
https://github.com/goodluck08/practice_dataset/blob/main/weather_2012.csv


• В задании 3 копируйте таблицу из Calc в Writer через буфер обмена; 

добавьте сноски для объяснения терминов (например, "CSV — формат 

для импорта в ИИ-фреймворки"). 

• В задании 4 экспериментируйте с типами диаграмм (линейная, 

столбчатая) — выбирайте подходящий для интерпретации данных в 

контексте ИИ (например, для выявления паттернов погоды). 

• В задании 5 сохраняйте в CSV для совместимости с ИИ-

инструментами; создайте структуру папок, имитируя реальный проект 

по интеграции ИИ (это развивает навыки организации данных). 

• В задании 6 примените условную формулу (например, 

=ЕСЛИ(D2>0;"Дождь";"Сухо")) — это демонстрирует базовую 

предобработку, необходимую для моделей ИИ; объясните в отчете, как 

сортировка помогает выявить выбросы в данных. 

• Время на выполнение: 1 час на ознакомление с интерфейсом и задание 

1, 1,5 часа на задания 2–3, 1 час на задания 4–5, 0,5 часа на задание 6 и 

оформление отчета. Если возникают ошибки (например, в импорте 

данных), используйте справку пакета (F1) для самостоятельного 

решения,. 

Формат отчета: Отчет о выполнении практической работы представляется в 

электронном виде (файл ODT или PDF) и включает: 

• Титульный лист: название работы, ФИО студента, группа, дата. 

• Описание выполненных заданий: скриншоты интерфейса (задание 1), 

заполненная таблица датасета (задание 2), текст документа-описания 

(задание 3), слайд с диаграммой (задание 4), структура папок 

(скриншот, задание 5), предобработанная таблица с обоснованием 

(задание 6). 

• Заключение: анализ, как офисные инструменты помогают в подготовке 

данных для ИИ (1–2 абзаца). 

• Список использованных источников (если применялись внешние 

датасеты).  

• Сдача: отправить по email преподавателю до конца занятия; при 

необходимости — устная защита (демонстрация файлов на экране). 

 

Тема практической работы №2. Управление файлами и папками: 

создание структуры каталогов для хранения датасетов ИИ, объем 

часов___4__ 

У1. Выбирать способы решения задач профессиональной деятельности 

применительно к различным контекстам. 



У2. Использовать современные средства поиска, анализа и интерпретации 

информации, и информационные технологии для выполнения задач 

профессиональной деятельности. 

Цель практической работы: Освоить навыки управления файлами и папками 

в офисных технологиях для организации и хранения датасетов, 

предназначенных для интеграции в модели искусственного интеллекта, с 

учетом профессиональных задач специалиста по работе с ИИ, обеспечивая 

эффективность сбора и предобработки данных. 

Задание(я): 

1. Откройте файловый менеджер операционной системы (например, 

Проводник в Windows или аналог в Linux) и создайте основную папку 

для проекта ИИ (например, "Проект_ИИ_Прогноз"). Изучите базовые 

операции: создание подпапок, переименование, копирование. 

2. Импортируйте простой датасет для ИИ в офисный пакет (например, 

Calc в LibreOffice). Пример датасета (источник - 

https://github.com/hunnydhouchak/Website-traffic-dataset/blob/main/data-

export.csv): таблица с данными о трафике сайта для модели 

предсказания посещаемости — столбцы: "Дата" (формат 

ДД.ММ.ГГГГ), "Посетители" (число), "Страницы просмотрено" 

(число), "Время на сайте (мин)" (число с плавающей точкой), 

"Источник трафика" (текст: "Поиск", "Социальные сети", "Прямой"). 

Пример строк: 01.01.2025, 150, 450, 3.5, "Поиск"; 02.01.2025, 200, 600, 

4.2, "Социальные сети"; и т.д. на 15–20 строк (создайте вручную или 

импортируйте из предоставленного CSV-файла преподавателем). 

3. Выполните базовые операции с файлом датасета: сохраните в формате 

CSV для совместимости с ИИ-инструментами (например, для загрузки 

в Python), скопируйте в подпапку "Сырые_Данные", создайте дубликат 

и переименуйте в "Обработанные_Данные.csv". 

4. Создайте структуру каталогов: в основной папке добавьте подпапки 

"Сырые_Данные" (для исходного датасета), "Обработанные_Данные" 

(для предобработанных файлов), "Документация" (для описания 

датасета в текстовом файле) и "Визуализация" (для презентации 

анализа). Переместите файлы соответственно. 

5. В текстовом редакторе (например, Writer) создайте файл 

"Описание_Датасета.odt" в подпапке "Документация": добавьте 

таблицу с примерами данных, аннотации столбцов и обоснование 

структуры каталогов для задач ИИ (например, почему разделение на 

сырые и обработанные данные важно для обучения моделей). 

6. (Дополнительное задание) Архивируйте всю папку 

"Проект_ИИ_Прогноз" в ZIP-файл и разархивируйте в новую локацию. 

Обоснуйте, как такая организация файлов улучшает работу с данными 



для моделей ИИ (например, предотвращает потерю данных и облегчает 

совместную работу). 

Методические указания по ходу выполнения работы (комментарии к 

заданиям, к выполнению заданий): 

• Перед началом убедитесь в наличии офисного пакета и файлового 

менеджера; используйте бесплатные инструменты, совместимые с 

российским ПО (например, Р7-Офис для импортозамещения). Для 

задания 2 примените пример датасета или адаптируйте из открытых 

источников (например, с Kaggle, но ограничьтесь 15–20 строками для 

фокуса на управлении файлами). 

• В задании 2 при импорте датасета проверяйте форматы ячеек (числа 

без текста в числовых столбцах) — это критично для качества данных в 

ИИ (избегайте ошибок, которые могут сломать модель, как смешанные 

типы). 

• В задании 3 используйте контекстное меню для операций (правой 

кнопкой мыши) —например, копирование vs. перемещение для 

сохранения оригинала. 

• В задании 4 структурируйте папки логично, имитируя реальный 

workflow ИИ: "Сырые_Данные" для исходных, 

"Обработанные_Данные" для очищенных — это соответствует ПК по 

подготовке данных для моделей. 

• В задании 5 вставьте таблицу из Calc в Writer; добавьте сноски для 

терминов (например, "Источник трафика — категория для сегментации 

в моделях ИИ"). 

• В задании 6 используйте встроенный архиватор ОС; в обосновании 

укажите, как архивирование экономит ресурсы и обеспечивает 

безопасность данных для интеграции ИИ. 

• Время на выполнение: 0,5 часа на задания 1–2, 1,5 часа на задания 3–4, 

1 час на задания 5–6, 1 час на оформление отчета. Если возникают 

проблемы (например, с импортом), обратитесь к справке или 

преподавателю для демонстрации самостоятельности. 

Формат отчета: Отчет о выполнении практической работы представляется в 

электронном виде (файл ODT или PDF) и включает: 

• Титульный лист: название работы, ФИО студента, группа, дата. 

• Описание выполненных заданий: скриншоты структуры папок (задание 

4), заполненный датасет в таблице (задание 2), текст описания (задание 

5), ZIP-файл (как вложение или ссылка, задание 6). 

• Заключение: анализ, как управление файлами помогает в подготовке 

данных для ИИ . 

• Список использованных инструментов и источников (если 

применялись внешние датасеты).  



• Сдача: отправить по email преподавателю до конца занятия; при 

необходимости — устная защита (демонстрация структуры файлов на 

экране). 

Тема практической работы №3. Создание и форматирование документа: 

использование заголовков, списков и различных шрифтов, объем 

часов___4__ 

У2. Использовать современные средства поиска, анализа и интерпретации 

информации, и информационные технологии  

У5. Осуществлять устную и письменную коммуникацию на государственном 

языке Российской Федерации  

У9. Пользоваться профессиональной документацией на государственном и 

иностранном языках 

Цель практической работы: Освоить навыки создания и форматирования 

текстовых документов в офисном пакете для описания и документирования 

датасетов ИИ, с учетом требований к профессиональной коммуникации, 

анализа данных и подготовки к интеграции в модели искусственного 

интеллекта, развивая умения работы с документацией на разных языках. 

Задание(я): 

1. Откройте текстовый редактор офисного пакета (например, Writer в 

LibreOffice или аналог в Р7-Офис). Изучите инструменты 

форматирования: панель шрифтов, стилей, списков и заголовков. 

Создайте новый документ и примените базовое форматирование 

(шрифт Times New Roman, размер 12, интервал 1,5). 

2. Импортируйте готовый датасет для ИИ из открытого репозитория 

Kaggle (пример датасета: таблица с данными о медицинских 

показателях для модели предсказания заболеваний — столбцы: 

"Пациент ID" (число), "Возраст" (число), "Пол" (текст: "М" или "Ж"), 

"Давление (мм рт. ст.)" (число), "Уровень сахара (ммоль/л)" (число с 

плавающей точкой), "Диагноз" (текст: "Здоров" или "Риск"). Пример 

строк: 001, 45, М, 120/80, 5.2, Здоров; 002, 52, Ж, 140/90, 6.5, Риск; и 

т.д. на 10–15 строк) Вставьте данные в таблицу документа.. 

3. Форматируйте документ как описание датасета: используйте заголовки 

(уровни 1–3 для разделов "Введение", "Описание столбцов", "Примеры 

данных"), нумерованные и маркерованные списки для аннотаций 

столбцов (например, маркеры для характеристик каждого поля), разные 

шрифты (курсив для терминов на английском, жирный для ключевых 

понятий). 

4. Вставьте таблицу с примерами данных датасета, добавьте сноски или 

ссылки на источники (например, "Данные адаптированы из открытого 

https://www.kaggle.com/datasets
https://www.kaggle.com/datasets


репозитория Kaggle для задач ИИ в медицине"). Убедитесь в 

соответствии правилам деловой коммуникации (ясный, 

структурированный текст на русском языке с учетом культурного 

контекста — профессиональный тон). 

5. Сохраните документ в формате ODT (для редактирования) и PDF (для 

распространения). 

6. (Дополнительное задание) Добавьте в документ раздел "Анализ 

датасета для ИИ": вставьте простую диаграмму (например, 

гистограмму возрастов из данных) и опишите, как форматирование 

помогает в предобработке для моделей ИИ (например, стандартизация 

полей для избежания ошибок в обучении). Обоснуйте выбор стилей для 

улучшения читаемости в профессиональной документации. 

Методические указания по ходу выполнения работы (комментарии к 

заданиям, к выполнению заданий): 

• Перед началом убедитесь в наличии офисного пакета; используйте 

бесплатные инструменты, совместимые с российским ПО (например, 

Р7-Офис для импортозамещения). Для задания 2 примените пример 

датасета или адаптируйте из открытых источников (например, с UCI 

Machine Learning Repository, но ограничьтесь 10–15 строками для 

фокуса на форматировании). 

• В задании 2 при создании таблицы проверяйте форматы ячеек (числа 

без текста) — это критично для качества данных в ИИ. 

• В задании 3 используйте стили заголовков (Heading 1–3) для 

автоматического создания оглавления — это развивает У5 по 

структурированной коммуникации (например, заголовок "Описание 

столбцов" с маркерами: "Возраст — числовой показатель для 

возрастной сегментации в ИИ"). 

• В задании 4 добавьте сноски (Insert > Footnote) для терминов на 

английском (например, "Blood pressure — артериальное давление");  

• В задании 5 экспортируйте в PDF для фиксации формата — важно для 

профессиональной передачи документов в проектах ИИ; если 

облачный сервис доступен, настройте совместный доступ для 

симуляции командной работы. 

• В задании 6 вставьте диаграмму из электронных таблиц (если 

интегрировано) или создайте вручную; в обосновании укажите, как 

визуализация помогает в интерпретации данных для интеграции ИИ 

(например, выявление выбросов перед обучением модели). 

• Если возникают проблемы (например, с вставкой таблицы), 

используйте справку пакета (F1) для самостоятельного решения. 

Формат отчета: Отчет о выполнении практической работы представляется в 

электронном виде (файл ODT или PDF) и включает: 



• Титульный лист: название работы, ФИО студента, группа, дата. 

• Описание выполненных заданий: скриншоты форматированного 

документа (задание 3), таблица датасета (задание 2), оглавление и 

сноски (задание 4), файлы в разных форматах (как вложения или 

ссылки, задание 5), диаграмма с анализом (задание 6). 

• Заключение: анализ, как форматирование документов помогает в 

описании датасетов для ИИ. 

• Список использованных источников (если применялись внешние 

датасеты или термины).  

• Сдача: отправить по email преподавателю до конца занятия; при 

необходимости — устная защита (демонстрация документа на экране с 

объяснением на русском языке). 

 

Тема практической работы №4. Создание многостраничного документа с 

таблицами, диаграммами и оглавлением, объем часов___4__ 

У2. Использовать современные средства поиска, анализа и интерпретации 

информации, и информационные технологии. 

У5. Осуществлять устную и письменную коммуникацию на государственном 

языке Российской Федерации с учетом особенностей социального и 

культурного контекста 

У9. Пользоваться профессиональной документацией на государственном и 

иностранном языках 

Цель практической работы: Освоить навыки создания и форматирования 

многостраничных документов в офисном пакете для подготовки 

профессиональных отчетов по интеграции ИИ-решений, включая вставку 

таблиц, диаграмм и оглавления, с учетом требований к анализу данных, 

деловой коммуникации и многоязычной документации в контексте 

специальности, используя готовые датасеты и визуализации из открытых 

репозиториев. 

Задание(я): 

1. Откройте текстовый редактор офисного пакета (например, Writer в 

LibreOffice или аналог в Р7-Офис). Создайте новый многостраничный 

документ и настройте базовое форматирование (шрифт Arial, размер 

12, интервал 1,5, поля 2 см). Добавьте титульный лист с заголовком 

"Отчет по интеграции ИИ-решений в анализ продаж" (ФИО студента, 

группа, дата). 

2. Импортируйте готовый датасет для ИИ из открытого репозитория 

Kaggle (пример: простой датасет "Sales Data" или аналогичный по 



продажам — скачайте CSV-файл с сайта kaggle.com, например, 

"superstore-sales" или предоставленный преподавателем эквивалент; 

столбцы: "Дата", "Продукт", "Количество проданных единиц", "Цена 

(руб.)", "Регион", "Прогноз ИИ (единиц)". Ограничьтесь 15–20 

строками для анализа). Вставьте данные в таблицу документа. 

3. Форматируйте документ как описание датасета: используйте заголовки 

уровней (Heading 1 для "Введение", Heading 2 для "Анализ данных"), 

списки (нумерованные для шагов интеграции ИИ, маркерованные для 

описания столбцов датасета), разные шрифты (курсив для терминов на 

английском, например, "Dataset", жирный для ключевых показателей). 

Разместите таблицу с данными на отдельной странице. 

4. Импортируйте готовую диаграмму: скачайте или скопируйте 

визуализацию (например, столбчатую диаграмму продаж по регионам) 

из того же датасета на Kaggle (или предоставленную преподавателем) и 

вставьте её в документ с подписью на русском ("Диаграмма 1. 

Динамика продаж для модели ИИ"). Добавьте оглавление (Insert > 

Table of Contents) и сноски для объяснения терминов (например, 

"Forecast — прогноз, рассчитанный для ИИ-модели"). 

5. Сохраните документ в формате ODT и PDF 

6. (Дополнительное задание) Добавьте раздел "Рекомендации по 

интеграции ИИ": импортируйте еще одну готовую визуализацию 

(линейный график прогноза из Kaggle) и опишите на русском, как 

форматирование отчета помогает в коммуникации результатов ИИ 

(например, оглавление для быстрого поиска, диаграммы для 

визуализации предсказаний). Обоснуйте выбор элементов для 

профессиональной документации в проектах ИИ. 

Методические указания по ходу выполнения работы (комментарии к 

заданиям, к выполнению заданий): 

• Перед началом убедитесь в наличии офисного пакета; используйте 

бесплатные инструменты, совместимые с российским ПО (например, 

Р7-Офис для импортозамещения). Для задания 2 скачайте датасет с 

Kaggle (регистрируйтесь, если нужно; выбирайте простой файл CSV, 

например, "sales-data-set" или аналогичный, ограничьтесь 15–20 

строками для фокуса на форматировании). 

• В задании 2 при импорте датасета из CSV проверяйте форматы ячеек 

(числа без текста) — это критично для качества данных в ИИ 

(избегайте ошибок, которые могут повлиять на модель, как 

несоответствие типов). 

• В задании 3 используйте стили заголовков для автоматического 

оглавления (например, маркеры для "Продукт — категория для 

сегментации в ИИ"). 

• В задании 4 импортируйте диаграмму как изображение (скриншот или 

экспорт из Kaggle) и вставьте через Insert > Image; добавьте сноски 



(Insert > Footnote) для терминов на английском (например, "Sales 

forecast — прогноз продаж для ИИ"). 

• В задании 5 экспортируйте в PDF для фиксации; настройте совместный 

доступ в облаке для симуляции командной работы по интеграции ИИ. 

• В задании 6 импортируйте визуализацию как изображение; в 

обосновании укажите, как визуализация помогает в интерпретации 

данных для ИИ (например, стандартизация для избежания ошибок в 

обучении модели). 

• Время на выполнение: 0,5 часа на задания 1–2, 1,5 часа на задания 3–4, 

1 час на задания 5–6, 1 час на оформление отчета. Если возникают 

проблемы (например, с импортом из Kaggle), используйте справку 

пакета (F1) для самостоятельного решения. 

Формат отчета: Отчет о выполнении практической работы представляется в 

электронном виде (файл ODT или PDF) и включает: 

• Титульный лист: название работы, ФИО студента, группа, дата. 

• Описание выполненных заданий: скриншоты форматированного 

документа (задание 3), импортированная таблица датасета (задание 2), 

диаграмма с оглавлением (задание 4), файлы в разных форматах (как 

вложения или ссылки, задание 5), анализ с рекомендациями (задание 

6). 

• Заключение: анализ, как многостраничный документ помогает в 

отчетности по интеграции ИИ  

• Список использованных источников (ссылка на Kaggle-датасет и 

визуализации). Сдача: отправить по email преподавателю до конца 

занятия; при необходимости — устная защита (демонстрация 

документа на экране с объяснением на русском языке). 

Тема практической работы №5. Создание электронной таблицы для 

расчёта данных: простые математические операции, форматирование, 

объем часов___4__ 

У2. Использовать современные средства поиска, анализа и интерпретации 

информации, и информационные технологии 

У3. Планировать и реализовывать профессиональное и личностное 

развитие, использовать знания правовой и финансовой грамотности 

У7. Содействовать сохранению окружающей среды, эффективно 

действовать в чрезвычайных ситуациях 

Цель практической работы: Освоить навыки создания и форматирования 

электронных таблиц в офисном пакете для расчёта и анализа данных, 

предназначенных для интеграции в модели искусственного интеллекта, с 



учетом требований к обработке датасетов и профессиональных задач 

специалиста по работе с ИИ. 

Задание(я): 

1. Откройте программу для электронных таблиц в офисном пакете 

(например, Calc в LibreOffice или аналог в Р7-Офис). Изучите 

интерфейс: панель инструментов для формул, форматирования ячеек и 

базовых операций. Создайте новый файл и настройте базовые 

параметры (шрифт Calibri, размер 11, выравнивание по центру для 

заголовков). 

2. Импортируйте готовый датасет для ИИ из открытого репозитория 

Kaggle (пример: простой датасет "Iris Dataset" или аналогичный по 

классификации — скачайте CSV-файл с сайта kaggle.com, например, 

"iris" или предоставленный преподавателем эквивалент; столбцы: 

"Sepal Length" (число), "Sepal Width" (число), "Petal Length" (число), 

"Petal Width" (число), "Species" (текст: "setosa", "versicolor", "virginica"). 

Ограничьтесь 15–20 строками для анализа). 

3. Выполните простые математические операции: добавьте столбец 

"Средняя длина" (формула: =СРЗНАЧ(A2:C2) для расчёта среднего 

между первыми тремя столбцами), столбец "Категория размера" 

(формула: =ЕСЛИ(D2>1; "Большой"; "Маленький")). Форматируйте 

ячейки: цвет заливки для "Большой" (зелёный), жирный шрифт для 

заголовков, числовой формат с двумя знаками после запятой. 

4. Добавьте фильтры и сортировку: отсортируйте таблицу по "Sepal 

Length" по возрастанию, примените фильтр для показа только строк с 

"Species" = "setosa". Убедитесь в соответствии требованиям к датасетам 

ИИ (чистые данные без ошибок). 

5. Сохраните таблицу в формате ODS (для редактирования) и CSV (для 

импорта в ИИ-инструменты 

6. (Дополнительное задание) Добавьте сводную таблицу: сгруппируйте 

данные по "Species" и рассчитайте средние значения по "Petal Length". 

Обоснуйте, как такие расчёты улучшают датасет для моделей ИИ 

(например, для выявления паттернов классификации перед обучением). 

Методические указания по ходу выполнения работы (комментарии к 

заданиям, к выполнению заданий): 

• Перед началом убедитесь в наличии офисного пакета; используйте 

бесплатные инструменты, совместимые с российским ПО (например, 

Р7-Офис для импортозамещения). Для задания 2 скачайте датасет с 

Kaggle (регистрируйтесь, если нужно; выбирайте простой файл CSV, 

например, "iris-dataset" или аналогичный, ограничьтесь 15–20 строками 

для фокуса на расчётах). 

https://www.kaggle.com/datasets
https://www.kaggle.com/datasets


• В задании 2 при импорте датасета из CSV проверяйте форматы ячеек 

(числа в числовых столбцах) — это критично для качества данных в 

ИИ (избегайте смешанных типов, которые могут вызвать ошибки в 

моделях, как в Scikit-learn). 

• В задании 3 используйте панель формул для вставки функций — это 

развивает навыки анализа данных (например, =СРЗНАЧ для 

усреднения, =ЕСЛИ для условной логики, имитирующей 

предобработку в ИИ). 

• В задании 4 примените Data > Sort и Data > Filter — 

экспериментируйте, чтобы увидеть, как сортировка помогает выявить 

аномалии в датасете для ИИ. 

• В задании 5 сохраняйте в CSV без форматирования (только данные) — 

важно для совместимости с ИИ-фреймворками; добавьте примечание 

через Insert > Comment для английского текста. 

• В задании 6 создайте сводную таблицу через Data > Pivot Table; в 

обосновании укажите, как агрегация данных упрощает анализ для 

интеграции ИИ (например, группировка для feature engineering). 

• Время на выполнение: 0,5 часа на задания 1–2, 1,5 часа на задания 3–4, 

1 час на задания 5–6, 1 час на оформление отчета. Если возникают 

проблемы (например, с формулами), используйте справку пакета (F1) 

для самостоятельного решения. 

Формат отчета: Отчет о выполнении практической работы представляется в 

электронном виде (файл ODS или PDF) и включает: 

• Титульный лист: название работы, ФИО студента, группа, дата. 

• Описание выполненных заданий: скриншоты заполненной таблицы 

(задание 3), результаты сортировки и фильтров (задание 4), файлы в 

разных форматах (как вложения или ссылки, задание 5), сводная 

таблица с анализом (задание 6). 

• Заключение: анализ, как расчёты в таблицах помогают в подготовке 

данных для ИИ (1–2 абзаца). 

• Список использованных источников (ссылка на Kaggle-датасет). Сдача: 

Загрузить файл в LMS (электронную систему колледжа) или отправить 

по email преподавателю до конца занятия; при необходимости — 

устная защита (демонстрация таблицы на экране с объяснением 

расчётов). 

 

 

 



Тема практической работы №6. Создание таблицы с использованием 

функций и формул для расчётов. Создание сводной таблицы для анализа 

данных, объем часов___6__ 

У2. Использовать современные средства поиска, анализа и интерпретации 

информации, и информационные технологии 

У3. Планировать и реализовывать профессиональное и личностное 

развитие, использовать знания правовой и финансовой грамотности 

У7. Содействовать сохранению окружающей среды, эффективно 

действовать в чрезвычайных ситуациях 

Цель практической работы: Освоить навыки использования функций, формул 

и сводных таблиц в электронных таблицах офисного пакета для расчёта и 

анализа данных, предназначенных для интеграции в модели искусственного 

интеллекта, с учетом требований к профессиональным задачам специалиста 

по работе с ИИ. 

Задание(я): 

1. Откройте программу для электронных таблиц в офисном пакете 

(например, Calc в LibreOffice или аналог в Р7-Офис). Изучите панель 

инструментов для формул, функций и сводных таблиц. Создайте новый 

файл и настройте базовые параметры (шрифт Arial, размер 10, 

выравнивание по левому краю для текста, по центру для чисел). 

2. Импортируйте готовый датасет для ИИ из открытого репозитория 

Kaggle (пример: датасет "Titanic Dataset" или аналогичный по 

классификации выживания — скачайте CSV-файл с сайта kaggle.com, 

например, "titanic" или предоставленный преподавателем эквивалент; 

столбцы: "PassengerId" (число), "Survived" (0/1), "Pclass" (число), "Sex" 

(текст), "Age" (число), "Fare" (число). Ограничьтесь 20–30 строками 

для анализа). 

3. Выполните расчёты с использованием функций и формул: добавьте 

столбец "Возрастная категория" (формула: =ЕСЛИ(E2<18; "Ребёнок"; 

ЕСЛИ(E2<60; "Взрослый"; "Пожилой"))), столбец "Нормализованная 

цена" (формула: =F2/МАКС(F:F) для относительного расчёта). 

Форматируйте ячейки: условное форматирование (зелёный для 

"Survived=1", красный для "0"), числовой формат с одним знаком после 

запятой. 

4. Добавьте фильтры и сортировку: отсортируйте таблицу по "Age" по 

убыванию, примените фильтр для показа только строк с "Pclass=1". 

Убедитесь в соответствии требованиям к датасетам ИИ (данные готовы 

к анализу без пропусков). 

5. Сохраните таблицу в формате ODS (для редактирования) и CSV (для 

импорта в ИИ-инструменты). 



6. (Дополнительное задание) Создайте сводную таблицу: сгруппируйте 

данные по "Pclass" и рассчитайте средние значения по "Age" и "Fare", а 

также сумму по "Survived". Обоснуйте, как сводная таблица улучшает 

анализ для моделей ИИ (например, для выявления корреляций перед 

классификацией). 

Методические указания по ходу выполнения работы (комментарии к 

заданиям, к выполнению заданий): 

• Перед началом убедитесь в наличии офисного пакета; используйте 

бесплатные инструменты, совместимые с российским ПО (например, 

Р7-Офис для импортозамещения). Для задания 2 скачайте датасет с 

Kaggle (регистрируйтесь, если нужно; выбирайте простой файл CSV, 

например, "titanic-dataset" или аналогичный, ограничьтесь 20–30 

строками для фокуса на расчётах). 

• В задании 2 при импорте датасета из CSV проверяйте форматы ячеек 

(числа в числовых столбцах) — это критично для качества данных в 

ИИ (избегайте смешанных типов, которые могут вызвать ошибки в 

моделях, как в Keras). 

• В задании 3 используйте панель формул для вставки функций — 

экспериментируйте с вложенными ЕСЛИ для категоризации и 

агрегационными функциями как МАКС для нормализации. 

• В задании 4 примените Data > Sort и Data > Filter — это поможет 

визуально проверить данные на аномалии перед интеграцией в ИИ. 

• В задании 5 сохраняйте в CSV без форматирования (только данные)  

• В задании 6 создайте сводную таблицу через Data > Pivot Table; в 

обосновании укажите, как группировка упрощает feature selection для 

ИИ-моделей. 

• Время на выполнение: 0,5 часа на задания 1–2, 1,5 часа на задания 3–4, 

1 час на задания 5–6, 1 час на оформление отчета. Если возникают 

проблемы (например, с вложенными формулами), используйте справку 

пакета (F1) для самостоятельного решения. 

Формат отчета: Отчет о выполнении практической работы представляется в 

электронном виде (файл ODS или PDF) и включает: 

• Титульный лист: название работы, ФИО студента, группа, дата. 

• Описание выполненных заданий: скриншоты расчётной таблицы 

(задание 3), результаты фильтров (задание 4), файлы в разных 

форматах (как вложения или ссылки, задание 5), сводная таблица с 

анализом (задание 6). 

• Заключение: анализ, как расчёты и сводные таблицы помогают в 

анализе данных для ИИ (1–2 абзаца). 

• Список использованных источников (ссылка на Kaggle-датасет).  



• Сдача: отправить по email преподавателю до конца занятия; при 

необходимости — устная защита (демонстрация таблицы на экране с 

объяснением расчётов). 

 

Тема практической работы №7. Создание простой презентации с 

текстом и изображениями, объем часов___4__ 

У2. Использовать современные средства поиска, анализа и интерпретации 

информации, и информационные технологии 

У5. Осуществлять устную и письменную коммуникацию на государственном 

языке Российской Федерации 

У6. Проявлять гражданско-патриотическую позицию, демонстрировать 

осознанное поведение 

Цель практической работы: Освоить навыки создания простых презентаций в 

офисном пакете для представления результатов интеграции ИИ-решений, 

включая добавление текста, изображений и визуализации данных, с учетом 

требований к деловой коммуникации и профессиональным задачам 

специалиста по работе с ИИ. 

Задание(я): 

1. Откройте программу для создания презентаций в офисном пакете 

(например, Impress в LibreOffice или аналог в Р7-Офис). Изучите 

интерфейс: панель инструментов для слайдов, текста, изображений и 

шаблонов. Создайте новую презентацию и настройте базовую тему 

(цвета, шрифты: заголовки — Arial Bold, размер 32; текст — Arial, 

размер 24). 

2. Импортируйте готовый датасет для ИИ из открытого репозитория 

Kaggle (пример: датасет "Heart Disease UCI" или аналогичный по 

предсказанию заболеваний — скачайте CSV-файл с сайта kaggle.com, 

например, "heart-disease-uci" или предоставленный преподавателем 

эквивалент; столбцы: "age" (число), "sex" (0/1), "cp" (число), "trestbps" 

(число), "chol" (число), "target" (0/1 для наличия заболевания). 

Ограничьтесь 15–20 строками для визуализации результатов ИИ). 

3. Создайте слайды с текстом: титульный слайд с заголовком "Результаты 

интеграции ИИ в анализ сердечных заболеваний" (ФИО студента, 

группа, дата); слайд "Описание датасета" с нумерованным списком 

столбцов (текст на русском, с объяснением: "age — возраст пациента"); 

слайд "Результаты ИИ" с маркерованным списком ключевых выводов 

(например, "Вероятность заболевания: 60% для группы >50 лет"). 



4. Добавьте изображения и визуализацию: вставьте изображение 

(скачайте релевантное с Kaggle или открытого источника, например, 

график корреляций из датасета) на слайд "Визуализация данных" с 

подписью на русском ("Изображение 1. Корреляция показателей для 

модели ИИ"); создайте простую диаграмму в презентации на основе 

данных (например, круговую диаграмму распределения по "target"). 

5. Сохраните презентацию в формате ODP (для редактирования) и PDF 

(для просмотра). 

6. (Дополнительное задание) Добавьте слайд "Рекомендации" с 

анимацией (появление текста по пунктам) и опишите на русском, как 

презентация помогает в коммуникации результатов ИИ (например, 

визуализация для демонстрации точности модели). Обоснуйте выбор 

элементов для профессиональной презентации в проектах ИИ. 

Методические указания по ходу выполнения работы (комментарии к 

заданиям, к выполнению заданий): 

• Перед началом убедитесь в наличии офисного пакета; используйте 

бесплатные инструменты, совместимые с российским ПО (например, 

Р7-Офис для импортозамещения). Для задания 2 скачайте датасет с 

Kaggle (регистрируйтесь, если нужно; выбирайте простой файл CSV, 

например, "heart-disease-dataset" или аналогичный, ограничьтесь 15–20 

строками для фокуса на презентации). 

• В задании 2 при импорте датасета скопируйте данные в слайд как 

таблицу или используйте для диаграммы — это упрощает 

визуализацию результатов ИИ. 

• В задании 3 используйте мастер слайдов для единообразия; добавьте 

переходы между слайдами для плавности презентации. 

• В задании 4 вставьте изображение через Insert > Image; выбирайте 

релевантные графики из датасета (скачайте с Kaggle как PNG), подписи 

размещайте под изображением для ясности. 

• В задании 5 экспортируйте в PDF для фиксации. 

• В задании 6 примените анимацию через Slide > Animation; в описании 

укажите преимущества визуализации для понимания предсказаний ИИ. 

• Время на выполнение: 0,5 часа на задания 1–2, 1,5 часа на задания 3–4, 

1 час на задания 5–6, 1 час на оформление отчета. Если возникают 

проблемы (например, с вставкой изображения), используйте справку 

пакета (F1) для самостоятельного решения. 

Формат отчета: Отчет о выполнении практической работы представляется в 

электронном виде (файл ODP или PDF) и включает: 

• Титульный лист: название работы, ФИО студента, группа, дата. 

• Описание выполненных заданий: скриншоты слайдов (задание 3), 

вставленное изображение с подписью (задание 4), файлы в разных 



форматах (как вложения или ссылки, задание 5), слайд с 

рекомендациями (задание 6). 

• Заключение: анализ, как презентация помогает в представлении 

результатов ИИ (1–2 абзаца). 

• Список использованных источников (ссылка на Kaggle-датасет и 

изображения). Сдача: отправить по email преподавателю до конца 

занятия; при необходимости — устная защита (демонстрация 

презентации на экране с объяснением слайдов). 

 

Тема практической работы № 8. Создание графиков и диаграмм для 

отчёта на основе таблиц, 

объем часов _6__ 

 У2. Использовать современные средства поиска, анализа и интерпретации 

информации, и информационные технологии 

У5. Осуществлять устную и письменную коммуникацию на государственном 

языке Российской Федерации 

У6. Проявлять гражданско-патриотическую позицию, демонстрировать 

осознанное поведение 

Цель практической работы: 

Освоить навыки создания графиков и диаграмм в офисном пакете на основе 

табличных данных из готовых датасетов ИИ, выбора подходящего типа 

визуализации и оформления элементов графиков/диаграмм для включения в 

отчёты и презентации по результатам интеграции ИИ-решений, с учётом 

требований к деловой коммуникации и профессиональным задачам 

специалиста по работе с ИИ.  

Задание(я): 

1. Подготовка табличных данных для визуализации. 

Откройте программу для работы с электронными таблицами 

(например, Calc в LibreOffice или аналог в Р7-Офис). Изучите панель 

инструментов построения диаграмм: мастер диаграмм, выбор типа 

диаграммы, настройка подписей и легенды. 

Импортируйте готовый датасет из открытого репозитория Kaggle 

(например, "Students Performance in Exams" — CSV-файл с сайта 

kaggle.com, набор «students-performance-in-exams» или 

предоставленный преподавателем эквивалент). Используемые столбцы, 

например: 

o gender (текст: "male"/"female"), 



o test preparation course (текст: "none"/"completed"), 

o math score (число), 

o reading score (число), 

o writing score (число). 

Ограничьтесь 20–30 строками для наглядной визуализации. 

Проверьте корректность отображения данных (числовые столбцы 

распознаются как числа). 

2. Создание базовых диаграмм по табличным данным. 

На основе импортированных данных создайте не менее двух 

различных диаграмм в электронных таблицах: 

o столбчатую диаграмму (например, средний math score по 

группам test preparation course — «прошёл курс» / «не 

проходил»); 

o круговую диаграмму (например, распределение студентов по 

признаку test preparation course или gender). 

Для каждой диаграммы настройте: заголовок на русском языке, 

подписи осей (для столбчатой диаграммы), отображение 

легенды, при необходимости — подписи значений. 

3. Создание сравнительного графика для отчёта по ИИ. 

Постройте ещё одну диаграмму, показывающую сравнение 

показателей, которые могли бы использоваться в модели ИИ 

(например, столбчатую диаграмму или линейный график средних 

значений math score, reading score, writing score для выбранной 

подгруппы студентов). 

Разместите диаграмму на отдельном листе или области таким образом, 

чтобы её можно было использовать в отчёте по результатам ИИ 

(чёткий заголовок, понятные подписи, читаемые шрифты). 

4. Оформление диаграмм для включения в отчёт/презентацию. 

Отформатируйте созданные диаграммы: 

o измените шрифты заголовков и подписей (например, заголовки 

— Arial Bold, размер 14; подписи — Arial, размер 11–12), 

o при необходимости настройте формат чисел (без лишних знаков 

после запятой), 

o убедитесь, что цвета столбцов/сегментов различимы и не мешают 

чтению подписей. 

Вставьте одну из диаграмм в текстовый документ или 

презентацию (Writer / Impress или аналоги в Р7-Офис), добавив 

подпись под диаграммой на русском языке (например, 

«Диаграмма 1. Средние баллы по предметам для отчёта ИИ»). 

5. Сохранение результатов работы в нескольких форматах. 

Сохраните файл электронных таблиц с исходными данными и 

диаграммами в формате ODS (для дальнейшего редактирования) и 

экспортируйте диаграммы для отчёта: 

o либо в виде PDF-документа (если диаграммы встроены в 

документ/презентацию), 



o либо в виде изображений (PNG/JPEG) для дальнейшего 

использования в других отчётах по ИИ-проектам. 

6. (Дополнительное задание) Создание инфографики и обоснование 

выбора визуализации. 

Создайте дополнительный слайд в презентации или отдельную 

страницу в текстовом документе, оформленную как простая 

инфографика: 

o разместите 2–3 ключевые диаграммы/графика, 

o добавьте короткие текстовые подписи-выводы (например, 

«Студенты, прошедшие подготовительный курс, в среднем 

показывают более высокий математический балл»), 

o при необходимости используйте простые графические элементы 

(фигуры, значки). 

Опишите на русском языке (в 5–7 предложениях), чем 

выбранные графики и диаграммы удобны для представления 

результатов ИИ-анализа данных (например, для отчёта заказчику, 

руководителю проекта по интеграции ИИ). Обоснуйте выбор 

типов диаграмм и оформления с точки зрения профессиональной 

презентации данных. 

Методические указания по ходу выполнения работы (комментарии к 

заданиям, к выполнению заданий): 

• Перед началом работы убедитесь в наличии офисного пакета, 

поддерживающего электронные таблицы и построение диаграмм 

(рекомендуется LibreOffice или отечественные аналоги, например, Р7-

Офис, в соответствии с курсом «ОП.08 Информационные 

технологии»). 

• Для задания 1 используйте готовый датасет из открытого репозитория 

Kaggle. При необходимости зарегистрируйтесь на сайте. Выбирайте 

простой CSV-файл, позволяющий строить наглядные диаграммы 

(например, "students-performance-in-exams" или аналогичный по 

образовательной аналитике); при импорте ограничьтесь 20–30 

строками для удобства визуального анализа. 

• При импорте данных следите, чтобы числовые показатели (баллы) 

были распознаны как числа: это важно для корректного построения 

диаграмм и последующей обработки данных в ИИ-инструментах 

(Python, библиотеки анализа данных и др.).  

• В заданиях 2–3 рекомендуется использовать «Мастер диаграмм» (Insert 

→ Chart / Вставка → Диаграмма): 

o сначала выделите диапазон данных, 

o затем подберите тип диаграммы в зависимости от задачи 

(распределение категорий — чаще круговая диаграмма, 

сравнение значений — столбчатая или линейная диаграмма), 



o проверяйте, чтобы подписи и легенда были понятны без 

дополнительного объяснения. 

• В задании 4 обращайте внимание на читаемость: 

o не перегружайте диаграмму мелкими подписями, 

o используйте единый стиль шрифтов и оформление, близкое к 

требованиям деловой документации (короткие, чёткие заголовки, 

отсутствие лишних декоративных эффектов). Это важно для 

корректной визуальной подачи результатов ИИ.  

• В задании 5 экспорт в PDF или изображения рекомендуется выполнять 

через меню File → Export / Экспорт. При экспорте диаграмм убедитесь, 

что разрешение изображения достаточно для демонстрации и печати 

(диаграммы не должны расплываться при увеличении). 

• В задании 6 при создании инфографики можно использовать готовые 

стили и шаблоны презентации или текстового редактора, но важно, 

чтобы основное внимание было на данных и выводах, а не только на 

визуальных эффектах. В текстовом обосновании сделайте акцент на 

том, как выбранные визуальные формы помогают интерпретировать 

результаты ИИ-анализа. 

• Примерное распределение времени: 

o 0,5 часа — на задания 1–2 (подготовка данных и базовые 

диаграммы), 

o 1,5 часа — на задания 3–4 (создание сравнительных графиков и 

оформление), 

o 1 час — на задания 5–6 (сохранение, инфографика и написание 

обоснования), 

o 1 час — на оформление отчёта. 

• При возникновении технических трудностей (например, диаграмма 

строится некорректно, не отображаются подписи) используйте 

встроенную справку офисного пакета (клавиша F1) или раздел помощи 

в меню программы, демонстрируя навыки самостоятельного решения 

типовых проблем.  

Формат отчёта 

Отчёт о выполнении практической работы представляется в электронном 

виде (файл ODS/ODP и/или PDF) и включает: 

• Титульный лист: 

название работы (Практическая работа №8. Создание графиков и 

диаграмм для отчёта на основе таблиц данных ИИ), ФИО студента, 

группа, дата. 

• Описание выполненных заданий: 

o скриншоты импортированного датасета в виде таблицы (задание 

1), 



o скриншоты созданных диаграмм (столбчатая и круговая — 

задание 2), 

o скриншоты сравнительного графика/диаграммы для отчёта 

(задание 3), 

o пример вставленной диаграммы в текстовый документ или 

презентацию с подписью (задание 4), 

o указание сохранённых форматов файлов (ODS/ODP, PDF или 

изображения — задание 5), 

o слайд или страница инфографики с текстовым обоснованием 

выбора визуализации (задание 6, при выполнении). 

• Заключение: 

краткий анализ (1–2 абзаца) о том, как использование графиков и 

диаграмм помогает в представлении и интерпретации результатов 

анализа данных для ИИ-решений (например, упрощает понимание 

различий между группами, позволяет быстро оценить эффект 

факторов). 

• Список использованных источников: 

ссылка на использованный Kaggle-датасет (и, при наличии, другие 

источники данных или визуализаций). 

• Сдача: отправить отчетные файлы преподавателю по электронной 

почте до конца занятия; по решению преподавателя возможно 

проведение устной защиты — демонстрации диаграмм и графиков на 

экране с кратким объяснением их смысла и применения в отчёте по 

ИИ-проекту. 

 

Тема практической работы № 9. Настройка совместного доступа к 

документам и работа с системой управления версиями, объём часов: 4 

У4. Эффективно взаимодействовать и работать в коллективе и команде 

У6. Проявлять гражданско-патриотическую позицию, демонстрировать 

осознанное поведение 

У7. Содействовать сохранению окружающей среды, эффективно 

действовать в чрезвычайных ситуациях 

У9. Пользоваться профессиональной документацией на государственном и 

иностранном языках 

Цель практической работы: 

Освоить настройки совместного доступа к документам и датасетам, 

научиться управлять версиями файлов в облачных офисных сервисах, 

выполнять коллективное редактирование и отслеживание изменений при 

работе с данными, используемыми для ИИ-проектов. 



Задание(я): 

1. Регистрация и вход в облачный офисный сервис. 

Выберите российский облачный офисный сервис (например, МойОфис 

Облако, Р7-Офис Облако, Яндекс 360). 

Создайте рабочую папку «ИИ-проект». 

Изучите интерфейс: панель инструментов, область файлов, функции 

совместного доступа, историю версий. 

2. Загрузка датасета для ИИ в облачное хранилище. 

Скачайте готовый датасет с Kaggle (например, “Netflix Movies and TV Shows” 

или аналогичный, CSV-файл). 

Загрузите его в папку «ИИ-проект». 

Переименуйте файл согласно требованиям деловой документации (например, 

Dataset_Netflix_v1.csv). 

3. Настройка совместного доступа к документам. 

Создайте текстовый документ «Описание датасета». 

Предоставьте доступ одногруппнику или преподавателю: 

• уровень «просмотр»; 

• уровень «комментирование»; 

• уровень «редактор». 

Добавьте в документ: 

• краткое описание структуры датасета (5–7 предложений), 

• пример записи на русском и английском языках (например, описание 

столбца rating — «возрастной рейтинг» / “age rating”). 

4. Управление версиями и фиксация изменений. 

Откройте историю версий документа «Описание датасета». 

Выполните: 

• создание новой версии вручную; 

• просмотр предыдущих версий; 

• добавление комментария к версии (например, «Добавлены примеры на 

английском языке»). 

Сохраните скриншоты значимых этапов. 

5. Совместная работа над документом. 



Организуйте коллективную работу (двое или более участников): 

• одновременно откройте документ, 

• внесите правки в разные разделы, 

• используйте чат или встроенные комментарии. 

Создайте раздел «Применение датасета в ИИ-моделях» (3–4 предложения). 

6. (Дополнительное задание) 

Настройте ограниченный внешний доступ (ссылка для чтения). 

Создайте файл README.md (или аналог в текстовом редакторе) с краткой 

инструкцией на русском и английском языках: 

• где находится датасет, 

• как к нему получить доступ, 

• кто отвечает за актуальность версии. 

Методические указания по выполнению работы 

• Перед началом работы выберите отечественное облачное решение, 

совместимое с российским ПО. 

• В задании 2 используйте готовый датасет Kaggle. Для удобства 

коллективной работы ограничьтесь одним CSV-файлом среднего 

размера. 

• При настройке совместного доступа обязательно проверяйте уровни 

доступа — это важно для корректной организации командной работы. 

• Используйте встроенные средства комментариев, отслеживания 

изменений и историю версий — эти функции критически важны при 

работе с большими датасетами в ИИ-проектах. 

• Для коллективного редактирования согласуйте обязанности участников 

заранее (кто редактирует, кто комментирует). 

• Экспорт версий рекомендуется выполнять в PDF для фиксации этапов 

развития документа. 

Формат отчёта 

Отчёт сдаётся в электронном виде (PDF / DOCX / ODT) и включает: 

• титульный лист (ФИО, группа, название работы); 

• описание выполненных заданий с краткими пояснениями; 

• скриншоты: 

o интерфейса облачного сервиса, 

o настроек совместного доступа, 

o истории версий, 

o примеров коллективного редактирования; 



• фрагмент документа на русском и английском языках (задание 3, 6); 

• заключение (1 абзац) о том, как облачные сервисы помогают в 

командной работе над ИИ-проектами; 

• список источников (ссылка на использованный датасет Kaggle). 

Сдача: отправить отчетные файлы преподавателю по электронной почте 

до конца занятия; по решению преподавателя возможно проведение 

устной защиты 

 

Тема практической работы №10. Работа с облачным офисом: 

редактирование документа в реальном времени несколькими 

пользователями, объём часов: 4 

У4. Эффективно взаимодействовать и работать в коллективе и команде 

У8. Использовать средства физической культуры для поддержания здоровья 

У9. Пользоваться профессиональной документацией на государственном и 

иностранном языках 

Цель практической работы: Освоить навыки одновременного 

редактирования документа несколькими пользователями, распределения 

ролей, ведения профессиональной документации и фиксации изменений в 

облачном офисе для задач ИИ-проектов. 

Задание(я): 

1. Создание общего документа для редактирования в облачном офисе. 

Создайте документ «План анализа данных для ИИ-проекта». 

Изучите функции: 

• индикаторы онлайн-участников, 

• распределение прав, 

• отслеживание изменений. 

2. Подготовка и загрузка данных для совместной работы. 

Скачайте с Kaggle готовый датасет (например, “World Happiness Report” или 

аналогичный). 

Загрузите его в общую папку «ИИ-проект». 

Создайте в документе раздел «Описание датасета» (на русском языке). 

3. Совместное редактирование в реальном времени. 

Организуйте одновременную работу минимум двух пользователей: 



• один участник дополняет раздел «Методы анализа», 

• второй — раздел «Ожидаемые результаты». 

Следите за индикаторами курсоров, синхронизацией изменений и цветовой 

маркировкой правок. 

Сделайте скриншот процесса совместного редактирования. 

4. Добавление материалов на двух языках. 

Создайте подраздел «Glossary / Глоссарий» с 5–7 терминами (например: 

dataset, feature, model accuracy) и переводами. 

Оформите список в единообразном стиле. 

5. Использование комментариев, предложений и обсуждений. 

Каждый участник должен: 

• оставить минимум 2 комментария; 

• предложить изменения в тексте (режим «Предложения» или 

аналогичный); 

• ответить на комментарий другого участника. 

Экспортируйте документ в PDF для фиксации комментариев. 

6. (Дополнительное задание) 

Создайте мини-регламент работы команды «Документ для ИИ-проекта: 

правила совместного редактирования» (0,5–1 страница). 

Разместите его в общей папке и выдайте доступ всем участникам. 

Методические указания 

• Для выполнения работы используйте тот же облачный офис, что и в 

практической работе №9 — это позволит сохранить структуру проекта. 

• Перед началом коллективной работы договоритесь о распределении 

ролей (кто редактирует какой раздел). 

• При совместном редактировании внимательно следите за 

индикаторами курсоров — это предотвращает конфликтные 

изменения. 

• Глоссарий рекомендуется оформлять таблицей или списком с чётким 

делением «термин — перевод». 

• Режим комментариев и предложений полезен для согласования 

профессиональной документации в ИИ-проектах. 

• Экспортируйте итоговый документ в PDF для фиксации обсуждений и 

комментариев. 



Формат отчёта 

Отчёт сдаётся в электронном виде и включает: 

• титульный лист; 

• описание выполнения заданий; 

• скриншоты работы в реальном времени (обязательно); 

• фрагмент документа на русском и английском языках; 

• примеры комментариев, предложений и принятых изменений; 

• PDF-версию итогового документа; 

• заключение (1 абзац) о роли коллективного редактирования в ИИ-

проектах; 

• список источников (включая Kaggle-датасет). 

Сдача: отправить отчетные файлы преподавателю по электронной почте до 

конца занятия; по решению преподавателя возможно проведение устной 

защиты 

II. Общие рекомендации 

По всем вопросам, связанным с изучением дисциплины (включая 

самостоятельную работу), консультироваться с преподавателем. 

III. Контроль и оценка результатов 

Оценка за выполнение практической работы выставляется по пятибалльной 

системе и учитывается как показатель текущей успеваемости студента. 

Качественная оценка 

индивидуальных 

образовательных достижений 

Критерии оценки результата 

балл 

(оценка) 

вербальный 

аналог 

5 

отлично — Выполнены все задания практической 

работы в полном объёме и без ошибок. 

— Правильно применены инструменты 

офисных пакетов, облачных сервисов, средств 

визуализации, форматирования и анализа 

данных. 

— Датасеты Kaggle корректно 

импортированы, данные обработаны верно, 

визуализации и документы оформлены 

профессионально. 

— Отчёт структурирован, включает все 

требуемые элементы (скриншоты, пояснения, 



выводы). 

— Демонстрируется уверенное владение 

материалом при устной защите (если 

предусмотрена). 

4 

хорошо — Выполнены все задания, но отдельные 

шаги могут содержать minor-ошибки 

(оформление диаграмм, структура документа, 

качество визуализации). 

— При работе с облачными сервисами могут 

допускаться несущественные неточности 

(например, формальные комментарии, не 

полностью корректная настройка доступа). 

— Отчёт оформлен правильно, но имеет 

небольшие недочёты (неполные подписи, 

недостаточно подробный вывод). 

— Задания выполнены самостоятельно, 

понимание материала продемонстрировано. 

3 

удовлетворительно — Выполнена большая часть заданий, но 

отдельные пункты выполнены частично, 

неправильно или пропущены. 

— Ошибки в работе с датасетами (форматы 

данных, отсутствие проверки числовых 

столбцов, некорректная визуализация). 

— Отчёт содержит структурные или 

содержательные недочёты (отсутствие части 

скриншотов, неполные пояснения, слабый 

вывод). 

— Работа с облачными сервисами выполнена 

поверхностно (например, настройка доступа 

или история версий отображены не 

полностью).  

2 

не 

удовлетворительно 

— Выполнено менее половины заданий или 

задания выполнены некорректно. 

— Серьёзные ошибки при работе с данными, 

форматированием, визуализацией и 

облачными сервисами. 

— Отчёт отсутствует или содержит 

фрагменты, не отражающие содержание 

работы. 

— Отсутствует корректная работа с 

датасетами, версиями документов, 

визуализациями или презентациями. 
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